Word to FlashBook
Pro

Create Professional flipping book with

Microsoft Word
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About Word to FlashBook Pro

Word to FlashBook Pro is a much professional
program to help you convert Microsoft Word into
stunning booklets with amazing page-flipping
animations and sound! Besides original classical
Word to FlashBook Standard features such as
adding background images and sound, Word to
FlashBook Pro also provides more powerful and
professional functionalities, like exporting defined
templates and settings to theme for later easy

using....

Note: This product is distributed on a "Try before-you-buy"
basis. All features described in this documentation are
enabled. The registered version doesn't insert a watermark in

your generated page-flipping eBooks.

Copyright 2010 by FlashBookMaker.com
-1-



b

—

Word to Professional Page-Flipping eBook Utility
User Document

Product features

1. Convert Microsoft Word to Adobe®© Flash® based page-flipping eBooks.

2. Output in 4 different formats: HTML, EXE, Zip and Burn to CD.

3. HTML allows you to upload to a website to be viewed online.

4. EXE and Zip allow you to send to your user by email to be viewed on
their computer.

5. Burn to CD allows you to burn to disk so you can send your user
physical media for viewing on their computer.

6. Preview the output effect instantly.

7. Import bookmarks (outline) with Word TOC, and edit them manually.

8. Including hyperlinks with Word, include web link, page link, email link.

9. Import text and search imported text with user-defined search terms.

10.Provide multiple templates (default provided or download from
website).

11.Set eBook size, choose landscape or portrait.

12.Watermark your page-flipping eBook using text, images, dynamic
date/time and more.

13. Define titles, keywords and other metadata.

14. Define titles, icon, window size for EXE page-flipping ebooks.

15. Define book margin size manually.

16.Add encryption to protect created page-flipping eBooks.
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17.Retain the book to center or not.

18. Insert background music, always play or define times.

19. Set background color, image or flash.

20.Set book reading from right to left (such as Arabic).

21.Choose hard cover for eBooks.

22.Set page-flipping time to be manual (reader-driver) or automatic (as
you design).

23. Customize toolbar buttons to set permissions for downloading, printing,
sharing and more.

24.Set colors for toolbar, book cover, book shadows, bookmarks and more.

25.Set font color, type for windows and bookmarks.

26.Set scale for zoom-in function.

27.Set control bars to "show" or "hide" in full screen.

28. Define language for flash.

29. Edit pages with links, videos, flash or sound files.

30. Export and save settings for future uses.

31.Save themes to make future use easier.

32.Save current files and settings as project.

33.Provide command line version.
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Page-flipping eBook features

With the page-flipping ebook you have created, your user will be able to:

1.

2.

Drag the corner, click page shadow or use arrow keys to flip a page.
Input login password to view eBook content.

Auto-view flipbook repeatedly.

Pre-loading of pages allows first pages to open quickly, viewers does
not need to wait until all pages have loaded.

View page thumbnails.

Use button to control page, such as Previous, Next, First, Last etc.

Flip pages automatically.

View page-flipping eBook full screen.

Search whole eBook.

10. Print out the whole eBook or a range of pages directly.

11.Download the uploaded page-flipping eBook from web site directly.

12. Double-click to zoom in or zoom out.

13. Links are still "live" and can be clicked to view after zooming in/out.

14.Share eBook URL via email.

15.Turn on or turn off the page-turning sound.

16.View video, flash or play sound file inserted in the pages.

17.0pen to a certain page in Browser by adding a suffix like this:

index.html?pagelndex=4.
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Quick Start

e

.

1. Launch the application via the desktop shortcut “— ;

~ 1.Add Flie
2. Click the "1. Add File" Tab icon “' to enter

into Import Word interface;

3. Click L #®"= |jcon to choose Microsoft Word file from your

computer;

4. Click icon to enter into template setting

interface;

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and

Apply Change
then click the "Apply Change" icon m ;

3. Publish
6. Click "Publish" Tab icon “i to enter into Output

interface;

7. Choose Output Type from HTML, ZIP and EXE, here take
'L.\_:E_,"F} 2 x.htl'l'l'
= as example;
8. Click L ®?"*= |t5 set Output Folder as "C:\flipbook", input File Name
as "demo";

| Lonvert |

9. At last, click icon to output created page-flipping eBook.
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You can open the "flipbook" folder in "C:", there are three files in this folder:

5 @

files book.swf dema.html

Open the "demo.html" file to view your created pOOage-flipping book via Web
Browser, such as Internet Explorer, Google Chrome, Firefox, etc.

& demo - Windows Internet Explorer E=neey x|
QQ - | ] Cfliphookidemo htmi | [ 42| % |[E 8ing P
< Favorites | 7 :
| @ demo [ fi » B ~ = @ v Pagev Safetyv Tookv @~ 7

FLIPBUILDER COM Fur PDF PrO

@ Internet | Protected Mode: Off 5 v ®10% -

Interfaces

There are some main interfaces you will see while using Word to
FlashBook Pro as below shows: Application Options, Import Word,
Template Settings, Edit Pages, Language Option, Export Theme, Output,

Batch Convert and Command Line.
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You can enter into each page to get clear instructions for every detail

option.

I. Application Options Interface

Render Engine Option
Word to FlashBook Pro provides 3 different render engines for you to create higher

quality page-flipping eBooks, click "Options->Application Options" to enter into
"Render Engine" interface:

Frerder Engene

Flease seleche a render engine for the conversion

Eleks
EL"."F
¥
[ S ]
GPL Ghostecript.  Doydoad Ghostecript
F
aseE

@ frmesr Library

SVWiF: Miuch legble characters, smaler output sire
. Ghostsomipt: Higher cofor ransfer gualbty

Inner Library: Faster convert speed

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

(Change option when Word imported failed)
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Il. Import Microsoft Word Interface

1. Add Flie 2. Style 3. Publish
4 ) 4

import PDF

C:\Users\Administrator \Desktop'scan to flipbook.doc [ Browse.. J | Open it
Page range to import Watermark

@ Al pages " Place a custom text or image

- POLE Watermark(Stamp) to the file{s)

(" Custom rage: Example:1,9-21,30 # o

% Set Watermark |

[¥] Quickly import {Only import 10 pages to initial preview)

Pages quality and size

Quality And Size: |High quality large file size - |

A% High values produce better page quality but require more disk space and more time to download.
Options

[V} Import bookmark [¥] Import finks [ Enable search [V] Detect wide pages

Panel Description:

1. Source Microsoft Word File:
Click this icon to open the Microsoft word file you want to convert;

Open it View content of added Microsoft Word file to clarify before converting.

2. The Page Ranges to Import:

©alpages oo hvert all pages to page-flipping eBook;

@ Custo 2125 E ler1,3,5,9-21 .
EEe xampie:1, Convert defined range page;

[¥] Quickly import (Only import 10 pages to initial preview) Just preview effect on first 10 pages

3. Watermark

l@ Add image or text watermark to flipping pages.
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Applying \Watermark

[ 2ta Tent watermark

Check this option first to choose default stamps or add new ones:

A Add Text Watermark

Text Name
Bame: Text Watermark

Postioninmargits  Margis

% W @Qlﬁ!ﬁ@}m:m
| = uf (5R: 20 :
[= | s]f = Bottom: 20

Text Effect:
Ogadty: 0%

E)

Taxl - Page-fipong ellook Macror -

Text Propertes:

Bant: ﬁ'ﬂrum":""____; /| Embedided font
e oo I
Stbes (] Bokd [ rakec i

Text Layout

Layoyl: |Fa -

Elmiesivle  off- ooy |2

Edit /’ e
Add text stamp B

Add image stamp- ] imege watermart

Page-thpping eBook

X ¥ &

Delete Image hase

Move down e

q:l

#  Move up et i

Trmage Effect
Dpacity: 0%

Rotaton: 4 T degres

Positorinmarpns Mangrs
o || s

i %0 i peghts

Bt to marges E [ Eteich 1o margee E

o
= = e
= [ol] = fottor: 5
st
| mmeters

Lo | [oma ]

4. Page Quality
There are five types of "Quality And Size":

High quality large file size
Medium guality medium file size
Low guality small file size
Lower guality smaller file size

5. Other Options:

Copyright 2010 by FlashBookMaker.com
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[l use first page's widitrand height s page proportion Select this option to use first page's

proportion as book proportion, or you can define in Template Setting interface;

[} tmport bookmark If your Word file contains bookmarks, check this option to use in output
page-flipping eBook;
[V 1mpert links If your Word file has links, check this to enable in flipbook;

Enable search ok this option to enable search functionality in created flipbook.

At last, click icon to enter into template setting interface.

lll. Template Settings Interface

= \
[ FLF o FlsshBock Stendsss Unregizsered — FIF <o FlashBock Standerd Overviss [P
: Gt e ke = - i x - » il s — =

File Comvert (Options Help

1. Add Flie 2. Style J 3. Publish J

Apply Change F

Design Setting Bookmark:

| Srolgarssettings [ .
 BlButtonsBar
ElHome Button
Home Button Visible  |Hide E

B Themes
Catalog:
Templates:

e
Classical il

Spread

ElPrint Config
Print Enable Mo
Print Wartermark File

seniDommoadsstnng

[l » |

‘Sound Loops
ElZoom Config
s COOMEVENERIE :

Word to FlashBook Pro provides three different templates at present: Classical,
Float and Spread.

Each template contains some unique settings, the below instructions will

show you details.
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The design setting interface contains below main parts:

Choose Template
Book

Sound

Tool Bar

Initial Show
Bookmarks

Links

Language
Security Settings
Font

Panel Description:

1. Choose Template

Panel Description:

i Themes
Catalog:

Templates

Classical
J

Click

icon to select templates from below interface:

Blank,

2. Book Panel:
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|ne.
L HardCover o Me
Flipping Time 0.6

(1) Book Title (only can be set in Float Template)

[ Book Tite

Customize book title for showing on the top of your flipbook.

(2) Hide Book Frame Bar

| Hide Book Frame Bar |'ves |

If don’t want to show the book frame bar, choose “Yes” in this option.

(3) Retain the book to center
| Retain the book to center |Yes i |

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for
embedding special background image, such as advertisement or company log.

Copyright 2010 by FlashBookMaker.com
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(4) Book Proportions
| BBook Proportions |

Please note that the values are not fixed in pixels or inches, they just represent a ratio for
"Page Width: Page Height", and the book size will be changed depend on your Explorer
Window Size.

(5) Book Margin

A. Book Margin (set in Classical Template):

- BookMargm — ], SRR ‘

"Book Margin" refers to the distance between the book and the toolbar.

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):
| _Top v |

Copyright 2010 by FlashBookMaker.com
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(6) Flash Window Color
| 000001

 Flash Window Color

This color will be applied on all flash windows, such as the book window, "Help" window,
"Print" window and so on.

(7) Page Background Color

. Page Background Color

—
I

When load pages, or if the page number of your Word file is odd, then the page (the last
page) will show with the "Page Background Color".

(8) Page Shadow

. EIPage Shadow :
ftpage shadow |50
_Right page Shadow 25

Page Shadow Opadty |0.5
Lefe page Shadow

—||=

Right page Shadow

The value also takes the value of Book Proportions as reference, and the value interval of
"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

(9) Background Config

A. Background Color:

Copyright 2010 by FlashBookMaker.com
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BlBackaround Config
BlBadkground Color (I
Gradient Color A |CJ0xFFFFPF
Gradient Color B | l0x000000
Gradient Anale |90

Gradient Color A
~

Gradient Color B

Define background for your flipbook with gradient color or pure color (the same color for

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two
colors.

B. Background Image setting in Classical and Spread templates:

ElBackground Image
Image File
Image position

"'.‘

Click the icon " =" to choose background image from your computer, and there are 11 kinds
of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

C. Background Image setting in Float template:

 BBadgroundImage | |

Quter Image File E:\Program.. l

/ Image position Scale to fit |

The Float template enables you to add two background images: Outer Image and Inner
Image. You can make Inner background image to show special information, such as
advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to

choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle
Right, Bottom Left, Bottom Center and Bottom Right

Copyright 2010 by FlashBookMaker.com
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(10) Right to Left
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in

"Right to Left" option:

| I'Rjght'To Left |'fes

|

Mext Page
T

(11) Hard Cover
If you want create hard cover effect (a book bound with rigid protective covers) for your

flipbook, choose "Yes" in "Hard Cover" option:

Hard Cover |Yes

(12) Flipping time
Flipping Time 0.6 Sets page flipping time in seconds according to your

needs. (Recommended second value is 0.6)

3. Sound Panel

ElSound
Enable Sound |Enable |
| soundFie nple 3. mp ke |
Sound Loops -1

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " =]" icon to choose "Sound File" from your computer,
then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing
flipbook, other value (N>0) stands for the times of playing the sound file.

Copyright 2010 by FlashBookMaker.com
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4. Tool Bar
]TDDI Bar I m wmerrernna
TDOI bar R R s Shl:ll"“' e e L .
§ Imn Culnr . DUfoFH:’f
ElzomConfig |
_Print Enable S :"f'es —
Sean:h E|u1:ton 5|‘|CIW

: Seard'l nghllght Culur ._ I:lﬂ:{ﬂi'FFDD
_IannInad setting

FuII Screen 'n.*;'|thc:lut Tnnl

.ISharE Eluttun

_Full Screen Button ¢ Shnw
HelpButton Shnw -
S iy e I e

ST o | —
Tool Bar on top |False

(1) Tool bar (only in Classical Template)

_Tool bar |show

............. LN I Show or Hide Tool bar in created flipbook.

(2) Icon Color

Icon Color | JoxFFFFL=|
7?7 Q ~ = Q

(3) Zoom Config

 HzoomConfg [
...Laamin enable — .iT'E.S.. .
Zoom Scale |15

To Enable Zoon In functionality, choose "Yes" in "Zoon in enable", then set "Zoom Scale", the

value is the times between zoomed page size and the current page size.
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(4) Print Enable
Print Enable Yes

Choose "Yes" in "Print Enable", then click icon to set print page range as below:
& Print w

= Print A1 Pages
_) Print Current Page

. Prnt Range
Example; 2 5.3-26

= Print

(5) Search Button

Sjearu.%_h Button _ 'Shqu"_e -

Search Highlight Color | CJ0xfAAO0
Select "Show" in "Search Button" (make sure you have check "Enable Search" option in
"Import Word" interface), then define "Search Highlight Color", after clicking "Search" icon

, you will see a popup box to input search words, then click Enter or "Search" button,

you will get the below searching result:

(6) Download setting

EllD.my'nI.oad .se‘.rﬁ.nﬁ.
Download Enable Yes 5
[ Download URL ADFDema. pdf!

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly,
you can use absolute path like "http://www. FlashBookMaker.com/FlipPDFDemo.pdf" or
relative path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the
PDF to the same path).

Then readers can click the icon E to download your uploaded PDF file directly.

Copyright 2010 by FlashBookMaker.com
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(7) Full Screen

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen
Button" option: Full Screen Button Shaw

. . .rn-: . . . . . 1] n
Then you can click icon to view flipbook in Full Screen, click icon m or "Esc

button to exit from the Full Screen.
Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode,
you can set "No" in "Full Screen without Tool Bar" (just in Classical Template):

Full Screen Without Toaol.. | Yes

(8) Help Button
To show tips about viewing flipbook, you can set "Show" in "Help Button" option:
Help Button Show

Then you can see the button and click to get the tips as below:

J Double click to zoom in or out

J Drag the page corner to wiew

(9) Share Button
If you want your flipbook viewers to send the link to their friends or clients, you can add a

share button in your flipbook for readers to send out your flipbook link immediately:
Hlshare Button

Share Button éhn',\'
Email Subject Rear my fii...
Email Body fink}

When the viewers click the share button E, they will enter into the Email interface with
the link of your flipbook in the Email body.
(10) Home Button

You can add a Home Button m on the toolbar to enable readers back to your home
page after viewing your page-flipping eBooks:

_BlHome Button ol
__ Home Button Visble  [Show
_ PagelRL  ihtip:/ifip..
Open Window |5elf

Copyright 2010 by FlashBookMaker.com
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(11) Auto Flip

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the
Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times
of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip

button “, the flipbooks will be flipped by staying 3 seconds per page); if you want to

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes":

(L Eltatrlee

T SR

05 o2 oo R =
Play Count {-1

_ Auto fipwhenstartup [tes

(12) Tool Bar on Top (set in Float Template)
If you want to place the toolbar in Float templates on the top of the flash eBook, you can set
"Tool Bar on Top" as "True":

Tool Bar on top True

[

.
et

=

5. Initial Show (set in Float/ Spread Template)
You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just
select "Bookmark" or "Thumbnails" in this option:

For Example, select "Thumbnails": ] L Upmrt

Then you will get flipbook shown with below initial interface:

sumncercon  Fup PDF PRO

Copyright 2010 by FlashBookMaker.com
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6. Bookmark

Design Setting | Bockmari |

| ElBaokmark
Fant color
Background color
Backiround sipha
Always Show Bockmark |
Fanle Position

rssaoscow | FUP PDF PRO

s L T

In "Design Setting" panel (only in Classical Template, in other templates, the colors will be
adjusted automatically based on your defined flash window color), you can set "Font color",
"Background color", "Background alpha" (refers to the background opacity, value interval:
0~1, "0" stands for the background is totally transparent), "Always Show Bookmark->True/
False" and "Panel Position->Left/ Right".

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import PDF"
interface, or you want to create new bookmarks for your flipbook, you can add bookmarks
even sub-bookmarks here, click "Add" icons and then input "Title" and "Page".

When click the bookmark button, it will popup the bookmark panel immediately, and

click on those bookmarks, it will jump to the defined page automatically

Copyright 2010 by FlashBookMaker.com
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FLip PDF Pro

Blinks

... Mouse aver color

L bnkalpha T

...Open Window - Blank
Enable after zoomingin  |Enable

Create your professional fipping book with POF files

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page"
interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers
to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent),
and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting
"Enable after Zooming in->Enable".

8. Language

| Language |English -|
it

You can set language for showing tools or tips in your created flipbook, and here is the
specialized instruction page for setting the "Language Option".

9. Security Settings

[ Security Settings Single Pase ]

If you want to protect your flash books with passwords, you can click "..." icon to enter into
"Flash Security Config" interface:
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L

Srgle Password oprtion mesns fhat users need e passward o view the fash ook

Exciude Front Papes option ks to set a page number, ol atier pages ant be
vieved vethout inputing password.

Senurdy Tyoe
ey Sacurily
1 .
% |
"\ & Srve Paddwnid: 127458
Protect Fage Rangs
& Pages
0 Exclude Front Pages ]

e Dase

Select "Security Type->Single Password", and input passwords into the box (there is no

restriction on password format at present). You can also set "Protect Page Range" as "All

Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4

algorithm to protect eBook pages, the eBook content pages will show nothing without

permission.)

10. Font

F3

Product features

| Fontoor N
 Button Font
. Window Font Calar

| WindowFont |
_|Bookmark Fonit Color
Bookmark Font

License Agreements

Howe to (irder

If you want to change fonts of toolbar buttons, flash windows even bookmarks, you can set

font types and colors in Font Panel.
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11. Export Theme

If you want to save the current template settings as your own style template for later uses,

antas??'ﬂne
you can click "Export as Theme" button| & to storing all current template

settings, include the background images, margin values, toolbar buttons and so on.

Then when you want to use later, just click "File->Import Themes", the theme will be added
to the templates selecting interface.

IV. Edit Pages

Now you can use Word to FlashBook Pro to edit imported pages directly, no matter you want to
add link, video, sound or image file.

Edit Pages . |
Just click "Edit Pages" button| rl

to enter into the editing interface:

You can insert links, images, sound files and movies to the pages as you will.

1. Add Link:

Click the icon and then draw a link box on the area you want to add link, then define

properties in below panel:
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Over Color: . Ovar Alpha:

M Down @ Up @ Move

Down Color: ij Down Alpha: ® Qver ® out

Mormal Color: MNormal Alpha:

® Gotopage @ Openalnk @ Cal Javascript function
URL:

Link Target: T % W

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. For example, you can show a pop-up light box while readers clicking some
image on page, or pop-up a questionnaire or other Web Form by clicking some text.

Just make sure the parameter you set in "Function" can be called in from HTML page.

Example:

Check "Call Javascript function" as action type, then input Function as "testLightBox("Hello, this is
a test"):

® Down © Up ™ Move

® Over ® Cut

Goto-page ™ Open alink @ Call Javascript function

Function:

B E=
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And then make sure the Javascript wrote into the index.html page as below image shows (the
same as you set in "Link Function"):

<head>
<title>PDF-Benl brochure 2010-100dpi</titles
<meta http-equiv="Content-Iype™ content="text/html; charset=utf-8" />
<meta name="Heywordas™ content="" />
<{meta name sgecription”™ content="" />
<meta name="Generator™ content="[Flip PDF wersion 3.0] at http://flipbuilder.com/" />

it/c3a™ media="screen™>
[ height:100%;
| margin:0; padding:0;

background-color: #
| display:none

<8cript type="text/javascript">

function testlighthx|strFrcmFlashﬁ{

glert (atrFromFlash) ;

}

<fscripty>

2. Add Movie:

Click icon and then draw a box like below on the page you want to insert FLV movie:

Then you can select and edit the movie in below panel:
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Movie Properties

Play Movie:

" : Maone
Stop Movie:
When page is viewed

When page is off viewed

3. Add Sound:

Click the icon - to draw sound box and then select sound file, set other options:

Play Sound:

Stop Sound:
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4. Add Flash:

Click icon . to insert SWF flash into your defined area of flipbook page:

i

N . . . X .
After adding links, flash, movie or sounds, you can click the |con. to save the settings and

back to the template setting interface.

V. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below
shows:
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EI Language Settings m

-

fou can new or edit & language for the Aach flipping book
meLabledwaJmhdmsm;mmatmbeMdawdnmm
] The language will be st in the fash template settings

Language Home:  (Crnese v) [ benionguge| [ Kopeete | (B sevess.| [ Giew. |

Language Seltings

Label Labled B T
Frrst Button B |
Next Page Button T—m = |
Last Button HE—m |
Pravious Page Sutton Bi—51
Dowinload Butten T4
Print Button $TEN
Search Button oS
Book Mark Button B
Help Button &
Enable FulScreen Button &R
Disable Fullsoreen Button e

L G e e B =S |

Panel Description:

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you five different languages for you to use:
English, Chinese Arabic, French and Greek.

Language Mame: iw ish !’]

Arabic
Chinese
i lll
French
Greek

You can also add other language for your own uses:

-
1. Click the button [ i lew La”g”agEJ and define name for the new language:

F‘] Mew Language g-‘

New Languiage |

[dame; French

Copy From; lE'lng

Click "OK" to save the new language in the list;
2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,
then click "Save And Edit Next":
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Kext Page Button

Mext Page

Last Button hast I Edti Language Item
Previus Pags Buttan Previgus pg ————————
Doweroad ::lm Dowriad || BEtLEmRage Strig |
Prink, Button Print

Saarch Button Seareh Label i FirstBution
Book Mark Button Boak Mark ~
Help Button Help |abeled:  Presdére|
Enable FulSoreen Button Enabla Fulls

Disabls Fullsersen Button Disainle Futd

| Bnemd Oim Busthne,

Somed O B

| sovesncedtrent | [ ox

Cancel

3. At last, you can get all Labels translated into your new language as the images shows:

Label

First Button

MNext Page Button

Last Button

Previous Page Button
Download Button

Print Button

Search Button

Book Mark Button

Help Button

Enable FullScreen Button
Disable Fullscreen Button

o imid P Bakbam

Labled

Premigre

Page suivante
Derniére

FPage précedente
Telécharger
Imprimer
Rechercher
Réservez Mark
Aide

Activer FullScreen

Désactiver FullScreen
| o Smamd

Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

33 Load..,
Load language file saving before for current using:

After setting template and language, click

apply the settings.
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VI. Output Interface

:E. PDF to FlashBook Stenderd Unregistered — PDF to FlashBook Standard Overview

File Convert Options Hslp

Qutput type

1. Add Flie 2. Style J 3. Publish

Path

Eptions

;3 @ *html O *%2p ﬁ% (@l # ©) *app

[V Also Make Mobile Version  Make output page-flipping eBock works on iPad, iPhone and Android mobile devices

é How to meke created eBooks available for others online?

Output Folder: C:\Jsers\Administrator \Documents Open

File Mame: index hitml

HTML Title: 4 Advanced

] Burn to CD
Options

CD Writer [O:ILG,G: PLDS  DVD-ROM DH-16D55 D15 hd

Disc title:

[ Make it automatically play the fipbook in €D

Output types:

1. HTML

@ o-m

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demo

_g ﬁdvanced]

Set Keywords, Description or even Script in the below interface:
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|g| Advanced Settings ﬁ
HTML Advanced Settings |
HTML Meta Settings
Tithe: demo

Keywords:  pdf, fipbook, page-fipping, eboak, online, website, fiash, background, music

Description:  This page-fipping eBook shows you the stunning flash effect on PDF pages, a

Add Scripts
You can put some tracking
code sudh as Google
Analytics here.
Need dosed<saript>tag)
[oome
2.ZIP
Bi @z
]

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by

clicking "Advanced" icon: &

Your recipients just need to uncompress the ZIP file and then they can view the HTML
flipbook instantly:

files

Ik‘?ﬁu:ler‘rm.htrnl

bunk.swf

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

T

demuo.exe

You can also define Icon and Opening Window Size in Advanced Settings:
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'U Advanced Settings b&‘

Exe Windaw Info

Caption: dema

I:m:sa we | | Defait |

Window Size Option

Maxmized Cuistom Size
@ Full Soreen
Lo | gancel

You can even burn the output flipbook to CD:

[¥]Burn to €D

CD Writer |D: 1:0;G: PLDS  DVD-ROM DH-16D55 VD15 » |

Disc title: |Page-Flipping eBook

After choosing output type, then check the option "Burn to CD", set "CD Writer", define

C i
"Disc title", at last click [ﬂjbutton to output flipbook in your defined type.

License Agreements

All copyrights to Word to FlashBook Pro (the Software) are exclusively owned by
FlashBookMaker.com. For more information, visit our website at
www.FlashBookMaker.com .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.
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THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.

How to Order

Order Online (http://www.FlashBookMaker.com/flippingbook-maker-pro\index.html) or
Order Toll Free 1-877-353-7297 (When you order toll free just give the operator the product
number of the product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)

4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:
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If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at support@FlashBookMaker.com .

Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you are not satisfy with the solutions
provided, please contact support team for help.

1. Frequently Asked Questions

You can find answers to questions about technique issues here: http://www.
FlashBookMaker.com/

2. Learn tutorial about Word to FlashBook Pro

We publish a video tutorial which shows you the easy procedure of dealing with Word to
FlashBook Pro, you can view this video to quickly handle the stunning tool:
http://www.FlashBookMaker.com/flippingbook-maker-pro/flippingbook-creator-pro.swf
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3. Get lost license code

Click here to look up the order » (http://www.regnow.com/cs/orderStatus)
You can pull up a copy of your order by entering your email address. After you find your

order, you may view its status, view details of your order (including the license key), and
obtain the invoice.

4. Contact Us

If you have other questions or requirements, contact us directly through our support Email:
support@FlashBookMaker.com, we will respond you ASAP.
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